Chapter 9
Working with Styles
Copyright

This document is Copyright © 2018 by the LibreOffice Documentation Team. Contributors are listed below. You may distribute it and/or modify it under the terms of either the GNU General Public License (http://www.gnu.org/licenses/gpl.html), version 3 or later, or the Creative Commons Attribution License (http://creativecommons.org/licenses/by/4.0/), version 4.0 or later.

All trademarks within this guide belong to their legitimate owners.

Contributors

Jean Hollis Weber  Bruce Byfield  Gillian Pollack

Acknowledgments

This chapter is updated from previous versions of the LibreOffice Writer Guide. Contributors to earlier versions are:

John A Smith  Jean Hollis Weber  Leo Moons
Ron Faile Jr.

This chapter is adapted from Chapter 7 of the OpenOffice.org 3.3 Writer Guide. The contributors to that chapter are:

Agnes Belzunce  Bruce Byfield  Daniel Carrera
Peter Hillier-Brook  Peter Kupfer  Ian Laurenson
Iain Roberts  Gary Schnabl  Barbara M. Tobias
Jean Hollis Weber  Sharon Whiston  Michele Zarri

Feedback

Please direct any comments or suggestions about this document to the Documentation Team’s mailing list: documentation@global.libreoffice.org

Note

Everything you send to a mailing list, including your email address and any other personal information that is written in the message, is publicly archived and cannot be deleted.

Publication date and software version

Published July 2018. Based on LibreOffice 6.0.

Note for macOS users

Some keystrokes and menu items are different on macOS from those used in Windows and Linux. The table below gives some common substitutions for the instructions in this book. For a more detailed list, see the application Help.

<table>
<thead>
<tr>
<th>Windows or Linux</th>
<th>macOS equivalent</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools &gt; Options menu selection</td>
<td>LibreOffice &gt; Preferences</td>
<td>Access setup options</td>
</tr>
<tr>
<td>Right-click</td>
<td>Control+click and/or right-click depending on computer setup</td>
<td>Open a context menu</td>
</tr>
<tr>
<td>Ctrl (Control)</td>
<td>⌘ (Command)</td>
<td>Used with other keys</td>
</tr>
<tr>
<td>F5</td>
<td>Shift+⌘+F5</td>
<td>Open the Navigator</td>
</tr>
<tr>
<td>F11</td>
<td>⌘+T</td>
<td>Open the sidebar Styles and Formatting deck</td>
</tr>
</tbody>
</table>

Documentation for LibreOffice is available at http://documentation.libreoffice.org/en/
Contents

Copyright.................................................................................................................................2
Contributors...........................................................................................................................2
Acknowledgments....................................................................................................................2
Feedback...................................................................................................................................2
Publication date and software version.....................................................................................2
Note for macOS users................................................................................................................2

Introduction.............................................................................................................................5

Creating custom (new) styles...................................................................................................5
  Style dialog..............................................................................................................................5
  Organizer page.......................................................................................................................5
  Style inheritance.....................................................................................................................6
    Example: Changing a property of a parent style....................................................................7

Working with paragraph styles...............................................................................................7
  Indents & Spacing page..........................................................................................................7
  Alignment page......................................................................................................................9
  Text flow options for paragraph styles................................................................................10
  Font options for the paragraph style....................................................................................11
    Specifying a relative font size............................................................................................11
    Selecting a language for a paragraph style.........................................................................12
  Options for positioning text..................................................................................................13
    Example: Rotating the text in a paragraph style..............................................................14
  Spacing options...................................................................................................................14
  Controlling tab stops............................................................................................................14
  Outline & Numbering page...................................................................................................15
  Setting up a drop cap............................................................................................................15
  Background (area), highlighting, and transparency...........................................................16
  Borders....................................................................................................................................17
  Using conditional paragraph styles....................................................................................17

Working with character styles..............................................................................................18
  Creating a new character style............................................................................................19

Working with frame styles......................................................................................................19
  How frame styles work.........................................................................................................20
  Planning the styles...............................................................................................................20
  Creating new frame styles.....................................................................................................21

Working with page styles........................................................................................................21
  Creating a new page style.....................................................................................................21
  Organizer page.....................................................................................................................21
  General settings for the page style.......................................................................................21
  Area and Border pages.........................................................................................................23
  Header and Footer pages.......................................................................................................23
  Columns page.......................................................................................................................23
  Footnote page.......................................................................................................................23
Working with list styles........................................................................................................23
  Creating a new list style..................................................................................................24
  Bullets, Numbering Styles, and Image pages..............................................................24
  Outline page..................................................................................................................24
  Position page................................................................................................................24
  Customize page.............................................................................................................26
Example: Creating a simple list style.............................................................................27
  Creating the CDTracks numbered list..........................................................................27
  Applying the list style....................................................................................................27
**Introduction**

Chapter 8, Introduction to Styles, describes the basics of how to use, apply, and manage styles. This chapter gives a more detailed description of how to create or modify some styles, using the many options available on the various pages of the Style dialog. It explains how these options affect the appearance of the style and how to use them efficiently.

The Style dialogs share many of the same pages as the manual formatting dialogs, so this chapter can also help you apply manual formatting (though you do not need that if you use styles).

**Creating custom (new) styles**

In addition to using the predefined styles provided by LibreOffice, you can add new custom (user-defined) styles. In Chapter 8, three methods are given for creating a new style: drag-and-drop, the **New Style from Selection** icon in the Styles and Formatting deck, and the Style dialog.

The first two of these methods are convenient because you can check the visual effects that the style produces before creating it. However, for full control over the style (and its relationship to other styles, you need to use the Style dialog, as described in this chapter.

---

**Note**

Table styles are created in a different way, as described in Chapter 13, Tables of Data.

---

**Style dialog**

Open the Styles and Formatting deck in the Sidebar. Select the category of style you want to create by clicking on the appropriate icon in the top part of the Styles and Formatting deck.

Right-click in the window and select **New** from the context menu. The dialog that is displayed depends on the type of style you selected. Many of the pages are the same as those used when applying manual formatting. Therefore, if you are familiar with manual formatting, you may already know how to use most of the options.

---

**Tip**

The dialogs used to create a new style and to modify an existing style are mostly the same, but with one exception: conditional styles have a different dialog. See “Using conditional paragraph styles” on page 17.

---

**Organizer page**

The **Organizer** page, shown in Figure 1, is common to all style categories (except Table styles), with only small differences between them. Therefore, it is described only once.

Depending on the style you are creating, you will find the following fields on this page:

- **Name**: present on all the categories. Use this field to name the style you are creating.
- **AutoUpdate**: only present for paragraph and frame styles. If this option is selected, then Writer will apply any manual modification to a paragraph or frame formatted with that style to the style itself.

---

**Caution**

If you are in the habit of manually overriding styles in your document, be sure that AutoUpdate is not enabled, or you may suddenly find whole sections of your document reformatted unexpectedly.
**Figure 1**: The Organizer page displayed when a new Paragraph style is created

- **Next Style**: only available for paragraph and page styles. Use it to specify which style will be applied to the next element of the same type. For example, a left page style is usually followed by a right page style, a first page style followed by a left page style, a heading followed by body text, and so on.

- **Inherit from**: available for paragraph, character, and frame styles; it determines the position of the style in the hierarchy. All the starting properties of the new style are inherited (copied) from the style specified here; see below for more information.

- **Category**: available for all styles; use it to associate the new style with one of the categories. Note that you cannot change the category of the predefined styles. Setting this field is useful when filtering the contents of the Styles and Formatting deck.

- **Contains**: shows a summary of the properties of the style.

### Style inheritance

When creating a new paragraph style or a new character style, you can use an existing style as a starting point for its settings. In this sense, LibreOffice links the styles together.

When style settings are inherited, a change in the parent style affects every style inherited from it. To see the connections between styles, switch to the Hierarchical view in the Styles and Formatting deck filter. For example, every Heading style (such as Heading 1, Heading 2) is inherited from a style called Heading. This relationship is illustrated in Figure 2.

Inheritance is a method to create “families” of styles in which you can change their properties simultaneously. For example, if you decide that all the headings should be green (such as in this guide), you only need to change the font color of the parent style to achieve the desired result. However, changes made to a parameter of the parent style do not override changes previously made to the same parameter in the child styles. For example, if you change the Heading 2 font color to green, a change of the font color of the Heading style (the parent style) to red will not affect the Heading 2 font color.

You can easily check which properties are specific to a style by looking at the **Contains** section of the Organizer page. If you want to reset the properties of a child style to that of the parent style, click the **Standard** button located at the bottom of each Paragraph and Character style dialog.
**Example: Changing a property of a parent style**

Suppose that you want to change the font of not only Heading 1 or Heading 2, but all headings. Open the Styles and Formatting deck, select the *Paragraph Styles* category, right-click *Heading*, then select *Modify* to open the Paragraph Style dialog for the Heading style.

Select the *Font* tab, then select a font and click *OK.*

![Figure 3: Select the Heading font](image)

Now, the fonts of all the heading styles (Heading 1 through Heading 10) are changed in a single operation. Figure 4 shows on the left a document using the headings 1, 2 and 3 and on the right the same document after changes have been made to the Heading style.

![Figure 4: Effect of changing the Heading style font](image)

**Working with paragraph styles**

Although this section describes most of the parameters scattered over the tabbed pages shown in Figure 3, you do not need to configure them all. In most cases, you need to modify only a few attributes, particularly if you link styles or base the new style on a similar one.

**Indents & Spacing page**

On the *Indents & Spacing* page (Figure 5), you can set up the indentation of the paragraph and the spacing between lines and between one paragraph and the paragraphs above and below.
Use the Indent section of the page to set up the indentation, using these parameters:

- **Before text:** controls the space in the selected unit of measurement between the left margin of the page and the leftmost part of the paragraph area. Entering a negative value results in the text starting on the left of the margin. This may be useful in situations where your left margin is quite wide, but you want the headings to be centered in the page.

- **After text:** controls the space in the selected unit of measurement between the right margin of the page and the rightmost part of the paragraph area. Entering a negative value results in the text extending into the right margin of the page.

- **First line:** enter the offset in this box (either positive or negative) of the first line of the paragraph relative to the paragraph area. A positive value increases the indentation of the first line, while a negative value makes the first line start to the left of the paragraph area.

- **Automatic:** select this box to allow Writer to automatically control the indentation of the first line. The value is calculated by Writer on the basis of the font size and other parameters.

Use the Spacing section of the page to determine the amount of vertical space above and below the paragraph. It is customary to include some “space above” in heading styles so that they are separated from the text body of the previous section without the need to insert empty paragraphs. Spacing between paragraphs is also normal in certain types of documents. The body text style of this guide is configured to leave some space between consecutive paragraphs. You can select the option to remove space between paragraphs of the same style.

**Note**

An option in **Tools > Options > LibreOffice Writer > Compatibility** controls whether space above and space below are added together (the default) or if the larger space is the only one that applies. See Chapter 21 for more information.
The spacing between paragraphs does not affect the spacing between lines within a paragraph, which is controlled in the Line spacing section. You can select one of the following values:

- **Single**: the default setting—applies a single line spacing to the paragraph. This is calculated automatically based on the font size.
- **1.15 lines**: sets the line spacing to 1.15 lines. This small increase often improves the appearance of text without using a lot of vertical space.
- **1.5 lines**: sets the line spacing to 1.5 lines.
- **Double**: sets the line spacing to 2 lines.
- **Proportional**: activates the edit box next to the drop-down list where you can enter a percentage value. 100% means a single line spacing, 200% double line spacing and so on.
- **At least**: this choice activates the edit box next to the drop-down list, where you can enter the minimum value (in your selected unit of measurement) to be used for the line spacing.
- **Leading**: if this is selected, you can control the height of the vertical space between the base lines of two successive lines of text, by entering a value, which is summed with the value of single line spacing, into the edit box.
- **Fixed**: this choice activates the edit box next to the drop-down list, where you can enter the exact value of the line spacing.

**Tip**

When using different font sizes in the same paragraph, the line spacing may be uneven. To obtain evenly spaced lines, select **Fixed** or **At least** in the drop-down list and a value that is large enough to create a spacing between the lines sufficient to account for the largest font size used.

The last parameter on this page is Register-true. This is a typography term used in printing; it refers to the congruent imprint of the lines within a type area on the front and the back side of book pages, newspaper pages, and magazine pages. The register-true feature make these pages easier to read by preventing gray shadows from appearing through between the lines of text. The register-true term also refers to lines in adjacent text columns that are of the same height.

When you define a paragraph, paragraph style, or page style as register-true, the base lines of the affected characters are aligned to an invisible vertical page grid, regardless of font size or of the presence of graphics. This aligns the baseline of each line of text to a vertical document grid, so that each line is the same height.

To use this feature, you must first activate the Register-true option for the current page style (refer to “General settings for the page style” on page 21). Then the Reference style and all the styles hierarchically dependent on it will have the Activate Register-True box selected. If you also want to activate the vertical grid for other styles (or not apply it to styles dependent on the reference style), you can specify that here.

**Alignment page**

Use the Alignment page to modify the horizontal alignment of the text, choosing between Left, Right, Center, and Justified. The results of the selection are shown in a preview window on the right-hand side of the page.

When selecting Justified alignment, you can also decide how Writer should treat the last line of the paragraph. By default, Writer aligns the last line to the left, but you can choose to align it to the center or to justify it (meaning that the words on the last line will be spaced in order to occupy it fully). If you have selected to justify the last line and select the Expand single word option, then
when the last line of a justified paragraph consists of a single word, this word is stretched by inserting spaces between characters so that it occupies the full length of the line.

The alignment page is also used to control the Text to Text vertical alignment, useful when you have mixed font sizes on the same row. Choose the element of the fonts on the line that will be aligned between Automatic, Baseline, Top, Middle, Bottom. Refer to Figure 6 for a visual representation of these reference points.

![Figure 6: Text to text vertical alignment: Baseline, Top, Middle, Bottom](image)

**Text flow options for paragraph styles**

The Text Flow page (Figure 7), has three parts: Hyphenation, Breaks, and Options.

![Figure 7: The options on the Text Flow page of the Paragraph Style dialog](image)

With **Hyphenation** selected, three parameters are available:

- **Characters at line end**: controls the minimum number of characters to be left on a line before inserting a hyphen.
- **Characters at line begin**: controls the minimum number of characters that can be placed at the beginning of a new line following a hyphen.
- **Maximum number of consecutive hyphens**: controls the number of consecutive lines that terminate with a hyphen. The typographical standard is 2.
If you prefer Writer to automatically control the hyphenation, select the **Automatically** option.

In the *Breaks* section, you can require a paragraph to start on a new page or column, as well as specify the position of the break, the style of the new page, and the new page number. A typical use for this option is to ensure that the first page of a new chapter always starts on a new (usually right-hand) page.

To always start a new page with a particular style (useful for starting chapters on a new page), choose the following settings:

- In the *Breaks* section, select **Insert**. Make sure that *Type* is set to **Page** and *Position* is set to **Before**.
- Select **With Page Style** and choose the page style from the list.
- To continue page numbering from the previous chapter, leave **Page number** set at 0. To restart each chapter’s page numbering at 1, set Page number to 1. Click **OK**.

**Note**

If you want the first page of a new chapter to always start on a right page, make sure that the page style for the first chapter page is set for the right page only by making this selection in the **Layout settings** field on the **Page** tab of the Page Style dialog.

The *Options* section of the *Text Flow* page provides settings to control what happens when a paragraph does not fit on the bottom of a page:

- **Do not split paragraph:** If a paragraph does not fit on the bottom of one page, the entire paragraph moves to the top of the next page. This could cause a large blank space at the bottom on the page.
- **Keep with next paragraph:** Use for headings or the lead-in sentence to a list, to ensure that it is not the last paragraph on a page.
- **Orphan control** and **Widow control:** Widows and orphans are typographic terms. An orphan is the first line of a paragraph alone at the bottom of a page or column. A widow is the last line of a paragraph that appears alone at the top of the next page or column. Use these options to allow paragraphs to split across pages or columns but require at least two or more lines to remain together at the bottom or top of a page or column. You can specify how many lines must remain together.

**Font options for the paragraph style**

Three pages of the Paragraph Style dialog are dedicated to settings controlling the appearance of the typeface: the *Font*, *Font Effects*, and *Position* pages. The use of the first two pages is straightforward. Many of the options used when creating a character style are discussed in “Creating a new character style” on page 19. Options that can be used when creating a paragraph style are described here.

**Specifying a relative font size**

If you are creating a style based on another style (linked style), you can specify a font size relative to that other style—either as a percentage or as a plus or minus point value (–2pt or +5pt). Relative font sizes are commonly used for Web pages.

For example, the paragraph style Heading 1 is based on the paragraph style Heading. The font size of the paragraph style Heading is 14pt, and the font size of paragraph style Heading 1 is specified as 130%. Thus, the resultant font size of text in a paragraph formatted with the Heading 1 paragraph style is 14pt times 130% = 18.2pt.
To specify a percentage font size: in the Paragraph Style dialog, select the *Font* tab. In the *Size* box, enter the percentage amount followed by the symbol % (see Figure 8). Similarly, you can enter a plus or minus sign followed by the number of points to be added or subtracted from the base font size.

To change from a relative font size back to an absolute font size, enter the desired font size in a specific measurement, such as points (denoted by the letters *pt*).

It is also possible to use a percentage font size for character styles.

![Figure 8: Selecting a type size based on a percentage](image)

**Selecting a language for a paragraph style**

The language selected for a document (on *Tools > Options > Language Settings > Languages*) determines the dictionary used for spell checking, thesaurus, hyphenation, the decimal and thousands delimiter used, and the default currency format. You can only use a language whose dictionary is installed.

Within the document, you can apply a separate language to any paragraph style. This setting has priority over the language of the whole document.

On the *Font* page of the Paragraph Style dialog, languages with installed dictionaries are marked in the Language list by a small icon (Figure 9). When checking spelling, Writer will use the correct dictionary for paragraphs with this style.

If you write documents in multiple languages, you can use the linked styles to create two paragraph styles that differ only in the language option. If you then want to change some of the other properties of the paragraph style, all you need do is to change the parent style.

To insert occasional words in a different language and avoid their being picked by mistake with the spelling checker, it is more convenient to use a character style, as discussed in “Creating a new character style” on page 19.

**Tip**

The selection [None] is useful when a paragraph includes text you don't want checked, like URLs and programming code.
Options for positioning text

The Position page of the Paragraph Style dialog collects all the options that affect the position of the text on the screen or printed page.

Use the Position section to control the appearance of superscripts and subscripts (characters above or below the normal line of type, as in H₂O). However, you will normally apply superscript and subscripts to groups of characters rather than to entire paragraphs. Therefore, it is strongly recommended to change these parameters only when defining a character style and, instead, leave the default settings for the paragraph styles.

The second section of the Position page controls the rotation of the paragraph area. Two common uses for rotated paragraphs are to put portrait headers and footers on a landscape page and to fit headings above narrow table columns (as shown in Figure 11).

Tip

Rotated table headings are usually more readable if they are angled, not vertical. To produce angled text, you need to create a text object from the Drawing toolbar and rotate it to any angle you wish. See Chapter 11, Images and Graphics.
Chapter 6, Formatting Pages: Advanced, describes how to create portrait headers and footers on landscape pages by rotating characters. You can achieve the same effect by defining a separate header or footer paragraph style specifically for landscape pages.

**Example: Rotating the text in a paragraph style**

As an example, we will apply rotated table headings to a pre-existing table.

1) Create a new paragraph style. Name it *Table Heading Rotated*.

2) On the Position page of the Paragraph Style dialog, in the Rotation / scaling section, select 90 degrees. Click **OK** to save the new style.

3) Select the heading row of the table and apply the new style. Any text in the cells of the heading row is now rotated.

4) If the headings are aligned to the top of the cells, you may want to change the alignment to the bottom of the cells, as shown in Figure 11. To do this, click the Bottom icon on the Table toolbar or select **Format > Alignment > Bottom** from the Menu bar.

**Spacing options**

Use the Spacing section of the Position page to control the spacing between individual characters in the paragraph. When selecting an option other than default in the drop-down menu, use the edit box to enter the value in points by which you want to expand or condense the text.

The **Pair Kerning** option (selected by default) increases or decreases the amount of space between certain pairs of letters to improve the overall appearance of the text. Kerning automatically adjusts the character spacing for specific letter combinations. Kerning is only available for certain font types and, for printed documents, only works if your printer supports it.

**Controlling tab stops**

Although borderless tables are generally considered a much better solution to space out material across a page, in some situations tabs are sufficient to do what you need, with the added advantages of being simpler to manage and quicker to apply.
Caution

If you need to use tabs, and you will be sending a document to other people, do not use the default tab stops. If the recipients of the document have defined default tab stops that are not the same as the ones you are using, the paragraph may look very different on their machines. Instead, define the tab stops explicitly in the paragraph or the paragraph style; then you can be sure that everyone will see the same layout.

To define tab stops in your paragraph style, use the Tabs page, shown in Figure 13. Here you can choose the type of tab: left, right, centered, or decimal; the character to be used as a decimal point; and the fill character—the characters that appear between the end of the text before the tab and the beginning of the text after the tab. You can also create a custom fill character by entering it in the corresponding box. Common use of a fill character is adding dots between a heading and a page number in a table of contents or underscore character when creating a form to fill in.

![Figure 13: Specifying tab stops for a paragraph style](image)

To create a new tab stop, specify its position relative to the left margin, the type of tab, and the fill character and click the New button. The new tab stop is then listed in the Position box on the left. Unfortunately, the only way to modify the position of a tab stop is to create a new one in the desired position and delete the old one using the buttons on the right-hand side of the page.

It is not possible to define tabs that exceed the page margin. In the rare cases where that may be needed, use a borderless table instead.

Outline & Numbering page

Use the Outline & Numbering page to assign an outline level to any paragraph style, as described in “Assigning outline levels to other styles” in Chapter 8. This feature enables you to create a table of contents that includes those paragraphs along with the headings using styles listed in Tools > Chapter Numbering.

You can also use this page to associate a paragraph style with a list style. Refer to Chapter 12, Lists: Tips and Tricks, for additional information, as well as an example.

Setting up a drop cap

If you want your paragraph to use drop caps (usually this is suitable for a first paragraph style), then you can predefined the properties in the Drop Caps page of the paragraph style dialog. Select the Display drop caps option to enable the other choices: the number of lines occupied, the number of characters to enlarge (if you want the whole first word, check the corresponding box), and the space between the drop caps and the text.

Working with paragraph styles | 15
Drop caps use the same font and have the same properties as the rest of the paragraph; however, you can easily modify their appearance by creating a specific character style and using it. For example, you may want the drop caps to be of a different color or apply an outline effect. Select the character style you want to use in the corresponding drop-down menu.

**Background (area), highlighting, and transparency**

Adding a background color or graphic to a paragraph is a good way to make it stand out without having to insert a frame. You can customize the background using the *Area* page of the Paragraph Style dialog. The choices are described in “Defining borders and backgrounds” in Chapter 5, Formatting Pages: Basics.

You may want to pay attention to the following points when working with the *Area* page:

- If you do not find the desired color in the list of predefined ones, you can define your own as described in Chapter 21, Customizing Writer.
- You can use a bitmap, hatching, pattern, or gradient instead of a solid color as background.
- Different backgrounds can be selected for the paragraph area and for the text in the paragraph. Use the *Highlighting* page for the text. Figure 16 shows the difference.
- The area treatment is only applied to the paragraph area. If you have defined an indented paragraph, the space between the paragraph and the margin does not have the paragraph's background color.

![Figure 16: Different Area and Highlighting colors](image)
On the Transparency page, you can choose the transparency options for the selected background. Values range from 0% (fully opaque) to +100% (fully transparent).

**Borders**

Borders are often used to set off paragraphs from the text without using a frame, or to separate header and footer areas from the main text area (such as in this guide), and to provide decorative elements in some heading styles. Consider the following points:

- Watch out for the effects that the spacing between borders and paragraph area produces on indentations and tabulations.
- If you want the border to be drawn around multiple paragraphs, leave the **Merge with next paragraph** option at the bottom of the page selected.
- Often, white space can have the same effect.

See Chapter 4, Formatting Text, for more about the **Borders** page.

**Using conditional paragraph styles**

Making a paragraph style conditional means it changes its formatting depending on where it is used. For example, you may want the style MyTextBody to be black by default but turn white when inside a frame with a blue background.

Probably the most common use for conditional formatting is with single-style outlining. Single-style outlining is a type of outline numbering designed with a Numbering style. Instead of using different styles for the various outline levels, it changes the number formatting when you press the **Tab** key to create a subordinate heading.

The only trouble with single-style outlining is that all levels look the same. This is where a conditional paragraph style comes in handy. Assign the paragraph style to an outline numbering style in the **Outline & Numbering** page and then open the **Condition** page. There, you can assign the levels of the outline numbering style to other paragraph styles. Then, when you press the **Tab** key while using the paragraph style, each level of the outline takes on different formatting, making single-style outlining even more convenient than it is on its own.

When you create a conditional style, you are saying “in this condition make this style look like that other style”. For example, “When typing into a footer, make this style look like the my_footer paragraph style; when typing into a table, make this style look like the table_text paragraph style”.

In addition to setting the normal (unconditional) properties of the style, you need to define which other style it will look like in different situations. You do this on the **Condition** page.

**Note**

Predefined styles (other than Text body) such as Default, Heading 1, and Heading 2 cannot be set to be conditional.

**Caution**

If you want to create a new style and make it conditional, you have to do it while the style dialog is still open for the first time. After the dialog closes, the **Condition** tab no longer appears in the dialog when it is reopened.
To set up a conditional paragraph style:

1) Define a new paragraph style.
2) Select all the paragraph properties for the style. Do not click OK!
3) Click the Condition tab.
4) Select the Conditional Style option.
5) Select the first condition in the Context list (left side of the dialog) and select the style you want for this condition in the Paragraph Styles list on the right-hand side.
6) Click Apply. The name of the paragraph style appears in the middle list.
7) Repeat steps 5 and 6 for each condition you want to have linked to a different style.
8) Click OK.

When the style is selected, you will see that the formatting of your text depends on the context.

**Working with character styles**

Character styles provide exceptions to the formatting in a paragraph style. They are applied to groups of characters, rather than whole paragraphs. They are mainly used when you want to change the appearance or attributes of parts of a paragraph without affecting other parts. Examples of effects that can be obtained by means of character styles are **bold** or *italic* typeface or colored words.

Two of the character styles used in this document are:

- Keystrokes use a custom KeyStroke style. For example:
  
  To set Writer to full screen, press Control+Shift+J.
• Menu paths use a custom MenuPath style. For example:
  To turn field shadings on or off, choose View > Field Shadings.

Other ways of using character styles are described elsewhere in this book. These uses include making chapter numbers, page numbers, or list numbers larger than the surrounding text and formatting hyperlinks. When inserting words in different language or words you do not want the spelling checker to detect as mistakes, you can define the language (if any) to be applied in the character style’s properties.

Creating a new character style

This section illustrates the use of the Character Styles dialog. The pages used to configure the style are described in the previous section on paragraph styles.

• Use the Organizer page to set up the hierarchical level of the new character style (if needed) and to give it a name.
• Use the Font page to determine the font, style, and size for the new character style. As with paragraph styles, you can specify the font size as a percentage or as an absolute value. You can also specify the language of the text to which a certain character style is applied, so you can insert words in a different language and have them spell checked using the correct dictionary.
• Use the Font Effects page to set up attributes such as font color, underlining, relief, or other effects. If you frequently use hidden text, for example, it is convenient to define a character style where the Hidden option is marked. Relief effects may be appropriate for a drop cap or to give more emphasis to the chapter number or other parts of the title.
• Use the Highlighting page to apply a colored background to the text. This yields the same effect as using the Highlighting tool on the Standard toolbar.
• Use the Borders page to apply a border and a shadow to the text, if so desired.
• Use the Position page to create a subscript in case you are not satisfied with the default one or even a sub-subscript which may be useful for certain scientific publications. In the same page, you can create rotated, condensed, or expanded text.

Note

When rotating a group of characters, you also need to specify whether the rotated text should fit in the line or if, instead, it is allowed to expand above and below the line. This property only becomes active for character styles.

Working with frame styles

Frames are often used as containers for text or graphics. To provide consistency in the appearance of frames used for similar purposes, it is a good idea to define styles for frames. For example, you might want photographs to be enclosed in a frame with a drop-shadowed border, line drawings in a frame with a plain border, marginal notes in a frame without a border but with a shaded background, and so on.

Writer provides several predefined frame styles, which you can modify as needed, and you can define new frame styles. The technique for defining and applying frame styles is similar to that for other styles.
How frame styles work

When an object is added to Writer, it is automatically enclosed in a frame of a predetermined type. The frame sets how the object is placed on the page, as well as how it interacts with other elements in the document. You can edit the frame by modifying the frame style it uses or by using a manual override when a frame is added to the document.

Because frames and objects are used together, it is sometimes easy to forget they are separate elements. In some cases, such as charts, you can edit the frame and object separately.

Unlike other elements that use styles, frames can be defined only partly by their style because their use can vary so much. Several elements of frames, such as the anchor and protected elements, need to be defined manually for individual frames.

You can format a frame manually when you select Insert > Frame. The dialog that opens contains all the settings available when frame styles are set up, as well as some that are only available when the frame is inserted.

Planning the styles

If you are using a mix of graphics, you may want to define two related styles, one with a border line for graphics with white backgrounds and one without a border for all other backgrounds. You also may want to design one or more frames for text only.

Otherwise, the default frame styles (listed in Table 1) cover most users’ needs. The only significant addition that you might need is one or more styles for text frames.

Table 1: Various frame styles and their uses

<table>
<thead>
<tr>
<th>Style</th>
<th>Comments and Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formula</td>
<td>The frame style used for formulas. The default includes AutoSize, which adjusts the size of the frame to the formula.</td>
</tr>
<tr>
<td>Frame</td>
<td>The default frame style.</td>
</tr>
<tr>
<td>Graphics</td>
<td>The default style for graphics. The defaults include autosizing to fit the graphic, no text wrap, and a thin border around the frame. These are reasonable defaults, except for the border. Unless the background of the graphic is white and the document’s background also is white, the border usually is unnecessary.</td>
</tr>
<tr>
<td>Labels</td>
<td>The default style for use with File &gt; New &gt; Labels. It seems to be used by LibreOffice automatically and is not intended for users at all.</td>
</tr>
<tr>
<td>Marginalia</td>
<td>A style for placing a frame beside the left margin. As the name suggests, the Marginalia style is intended for comments added in the margin of text. The style also is useful for creating sideheads—headings against the left margin, which often are used in technical documentation.</td>
</tr>
<tr>
<td>OLE</td>
<td>The default style for OLE objects and floating frames. The default places the frame at the top and center of a body of text.</td>
</tr>
<tr>
<td>Watermark</td>
<td>The default style for a watermark, a graphic placed as the background to a body of text. The default is a Through wrap, with text passing over the frame and anything in it. The graphic should be faint enough that text still is readable over top of it.</td>
</tr>
</tbody>
</table>
Creating new frame styles

You can access frame settings by selecting **New** or **Modify** in the Styles and Formatting deck for a frame style.

- **Type** page: sets the size and position of the frame. One of the most useful options here is AutoSize, which automatically adjusts the frame to the object it contains. If the frame style is used automatically, then this option should be selected.
- **Options** page: sets whether the contents of the frame are printed and able to be edited in a read-only document. This page also sets the text direction, which is useful if you are using the frame for contents in a language that uses right-to-left text direction.
- **Wrap** page: sets how text is positioned in relation to the frame and how close text comes to a frame. If you want the frame contents to stand out from the paragraphs around it, set the wrap to None. This probably is the single most important page for frames.
- **Area** page: sets the background color, bitmap, hatching, gradient, or pattern. This page is useful mostly for text frames in complex page layouts, in which a text frame has an appearance different from the general background of the page.
- **Transparency** page: sets the transparency options for the selected background. Values can range from 0% (fully opaque) to +100% (fully transparent).
- **Borders** page: sets the attribute for a line around the frame, if any.
- **Columns** page: this page can be ignored unless the frame is being used for text. The page is the same as is used to set up a page style, as described in Chapter 6, Formatting Pages: Advanced.
- **Macro** page: sets a macro to use with the frame in order to trigger an action when the user interacts with the frame. These options are useful for an on-line Writer or HTML document.

Working with page styles

Page styles control page properties (margins, page size, header and footer, among others). However, unlike paragraphs, which can have directly applied properties, pages only have a page style and no directly applied properties.

This section describes how to create a new page style, explains the meaning of some of the options in the Page style dialog, and illustrates their usage.

Creating a new page style

To create a new page style, open the Styles and Formatting deck and click the **Page Styles** icon. Right-click anywhere in the window and select **New**.

The Page Style dialog contains nine pages.

Organizer page

The **Organizer** page is described on page 5.

General settings for the page style

The **Page** page of the Page Style dialog is where you can control the general settings of the page. The page consists of three sections, plus a preview area in the top right.

In the **Paper format** section, you can specify the size of the paper, choosing from one of the many predefined formats. Select **User** to define your own paper size using the Width and Height fields. Select the orientation of the paper: Portrait or Landscape. If your printer has more than one tray, you can specify the tray from which to print pages in the new page style.
In the Margins section, specify the size of the margins in your preferred unit of measurement. If you select Mirrored for Page layout in the Layout settings section, then the names of the margins change from Left and Right to Inner and Outer.

In the Layout settings section, choose the desired Page layout from the four available options. Decide whether the page style being defined applies to both left and right pages (default), or applies to right or left only. Some considerations:

- If you plan to bind the printed pages using this style like a book, select a mirrored layout. Use the Format drop-down menu to determine the page numbering style to apply to this page style.

- A common practice in page layouts is to have asymmetrical page margins—both for left and right margins and for top and bottom margins. The most common scheme follows these two general rules for printed page layouts: (a) The outer margin (right margin on a right-hand page) would be wider than an inner margin (left margin on a right-hand page); (b) The bottom margin would be larger than a top margin. The rationale for an asymmetrical page layout is allowing more space for readers to place their hands while holding the books or other printed documents. See Bruce Byfield’s book, Designing with LibreOffice, for more information. You can download a PDF free from http://designingwithlibreoffice.com.

- If you want the first page of a new chapter to always start on a right page, make sure that the page style for the first chapter page is set for the right page only by making this selection in the Layout settings field. The typical procedure for the rest of a chapter is to define a single “mirrored” page style for both left and right pages. A mirrored page can have different headers and footers. If done this way, every chapter will use two page styles.

- You can choose to define separate page styles for left and right pages, if you want the pages to be very different in appearance (for example, different margins or headers and footers only on right pages but not on left pages; imagine a book with a full-page photograph on the left pages and text on the right pages). In that case, make sure that the Next Style field for the first page style is set for a left-only page, which, in turn, is set to be followed by a right-only page style. If done this way, every chapter will use three page styles. A hypothetical case might have these page-style names: First page, Left, and Right.

If you check the Register-true box, Writer will create an invisible vertical grid on the page with a spacing between grid points that depends on the selected Reference Style. The vertical grid makes sure that text printed on adjacent columns, opposite pages, or even both sides of the same sheet of paper, is aligned—making it easier to read as well as being more pleasant to see.
**Area and Border pages**

The *Area* and *Border* pages are described in detail in Chapter 5, Formatting Pages: Basics. Use the *Area* page to apply a background or the *Border* page to draw a border around the text area of the page (the margins). You can also add a shadow to the text area. You can choose between a solid color or a graphic image for the background and several styles of line for the borders. The page area affected by these changes does not include the area outside the margins.

If you plan to print on colored paper and want to have an idea of the final result or want to use a light color for the font, rather than changing the background, then go to **Tools > Options > LibreOffice > Applications Colors** and in the *General* section, change the Document background color. This will affect the entire page, including the area outside the margins, but the background color will not print or be exported to PDF.

**Header and Footer pages**

You can associate a different header or footer with each page style. This property makes it easy to have different headers on left and right pages, to avoid headers on pages at the start of a new chapter, and so on. You can also have a different header or footer on the same page style where it is used for the first page of a document.

You can specify a different header for left or right pages even if you use a single style for both. This option is not available on the predefined *Left* and *Right* page styles or on any other page style defined to be a left or right page only.

The Header and Footer pages are described in detail in Chapter 5, Formatting Pages: Basics.

**Columns page**

Use the *Columns* page to create the column layout for the page style. It has three sections: Settings, Width and Spacing, and Separator Line. Choose the desired number of columns. If you select more than one column, the Width and Spacing section and the Separator Line section become active. You can use the predefined settings (equally spaced columns) or deselect the AutoWidth option and enter the parameters manually. When you work with multiple columns per page, you can also fine tune the position and size of a separator line between the columns.

**Footnote page**

Use the *Footnote* page to adjust the appearance of the footnotes. See Chapter 5, Formatting Pages: Basics, for details.

**Working with list styles**

List styles (also called numbering styles) work together with paragraph styles. They define indentation, alignment, and the numbering or bullet characters used for list items. You can define many list styles, from simple bulleted lists to complex multi-level (nested) lists.

As with other styles, the main reasons for using list styles are consistency and speeding up your work. Although you can create simple lists quickly by clicking the Numbering On/Off or Bullets On/Off icons on the Formatting toolbar, and create quite complex nested lists using the icons on the Bullets and Numbering toolbar, the appearance of the resulting lists may not be what you want,
and you might want to have more than one style of list. You can use the Bullets and Numbering choice on the Format menu to manually format the appearance of some or all of the lists, but if you later need to change their appearance, you will have a lot of manual work to do.

See Chapter 12, Lists: Tips and Tricks, for details on how list styles and paragraph styles work together.

Note

LibreOffice uses the terms “numbering style” and “list style” inconsistently, but they are the same thing. For example, the tooltip in the Styles and Formatting deck says List Styles, but its style dialog says Numbering Style.

Creating a new list style

The dialog to create a new list style includes six pages in addition to the usual Organizer page discussed on page 5.

Bullets, Numbering Styles, and Image pages

The Bullets, Numbering Style, and Image pages contain predefined formatting for list item symbols (bullets or numbers). To use one of them for your style, click the image. A thick border indicates the selection. The bullets on the Bullets page are font characters; those on the Image page are graphics.

Outline page

Use the Outline page to select from eight predefined nested lists. You can also select one and use it as a starting point for your own style, customizing the list using the Position page and the Customize page, as described below.

Position page

Use the Position page (Figure 20) to fine tune the indentation and spacing of the list item symbol and the text of the list item. This page is particularly effective when used in combination with the Customize page.

You can adjust the following settings for each individual level or all levels at once (to make them all the same). It is generally easier to adjust the settings in the order given below, instead of the order on the dialog. That is, start from the overall indentation for the list elements, then fix the position of the symbols, and finally adjust the alignment of the symbols.

- **Numbering followed by:** the character to follow the numbering symbol (plus any characters—for example a punctuation mark—chosen on the Customize page to appear after the number). Choose between a tab stop, a space, or nothing. If you select the tab stop, you can specify the position of the tab.
- **Indent at:** how much space is reserved for the numbering symbol, measured from the left page margin. The alignment of the first line of the list is also affected by any tab you may have set to follow the numbering.
- **Aligned at:** the position of the numbering symbol, measured from the left margin of the page.
- **Numbering alignment:** how the numbering (including any text before or after as set in the Customize page) will be aligned. The Aligned at value determines the symbol alignment.
In most circumstances, setting the *Numbering followed by* distance to be equal to the *Indent at* distance works well. See Figure 21 for a graphic representation of the effects of the above parameters.

**Figure 20:** Position settings for a List style

To fully appreciate how the Numbering alignment works, try to create a numbered list with more than ten elements and make sure that enough room has been made for numbers with two or more digits. You may also wish to right-align numbers 10 or greater, as in Figure 21.

**Figure 21:** A numbered list of CD tracks highlighting the various elements
**Customize page**

Use the *Customize* page (Figure 22) to define the style of the outline levels. The options available on this page depend on the type of marker selected for the list. First, on the left side, select the level you want to modify. To modify all ten levels at once, select 1 – 10 as the level. If you started from a predefined outline, some of the levels will already have settings.

![Diagram of Customize page for a list style](image)

*Figure 22: The Customize page for a list style*

Depending on the numbering style selected in the *Number* box (bullet, graphic, numbering), some of the following options become available on the page (not all are shown in the illustration):

- **Show sublevels:** The number of previous levels to include in the numbering style. For example, if you enter "2" and the previous level uses the "A, B, C..." numbering style, the numbering scheme for the current level becomes: "A.1".
- **Before:** any text to appear before the number (for example, Step).
- **After:** any text to appear after the number (for example, a punctuation mark).
- **Start at:** the first value of the list (for example, to start the list at 4 instead of 1).
- **Character Style:** the style to be used for the number or bullet.
- **Character button:** click to select the character for the bullet.
- **Graphics Select button:** opens a list of available graphics (Gallery) or allows the selection of a file on the hard disk to be used as the list marker.
- **Width and Height:** the dimensions of the graphic marker.
- **Keep ratio** option: fixes the ratio between the width and the height of the graphic marker.
- **Alignment:** the alignment of the graphic object.

The right-hand side of the dialog shows a preview of the modifications made.

If you choose the *Link Graphics* option in the *Number* list, the graphic object is linked rather than embedded in the document. The bullet will not be displayed when the document is opened on a different computer (unless the same graphic file is located in the same location on both computers) or if the graphic file used is moved to a different location on the computer.
To revert to the default values, click the **Reset** button in the bottom right corner. Finally, if you wish to use consecutive numbers regardless of the outline level, select the **Consecutive numbering** box at the bottom of the page.

**Example: Creating a simple list style**

In this example, we will create a numbered list that is used to number the songs on a CD. The numbers are right-aligned, and some space is left between the number and the title of the track.

As we want to reuse the same numbered list for other CDs, we will define a new list style and then apply it to the tracks list.

**Creating the CDTracks numbered list**

As for the previous example, start by clicking the List Styles icon (fifth from the left) in the Styles and Formatting deck. Then right-click anywhere in the list box and choose New.

The Numbering style dialog is displayed. For the CDTracks style, we need to customize fields in the Organizer, the Options, and the Position pages.

<table>
<thead>
<tr>
<th><strong>Style fields</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter CDTrack</td>
</tr>
<tr>
<td>Category</td>
<td>Custom styles will be OK for us.</td>
</tr>
</tbody>
</table>

Modify the options of the **Customize** page as follows:

1) In the **Level** box, choose 1.  
2) In the **Number list**, choose 1, 2, 3,....  
3) Leave the **Before and After** boxes empty.  
4) Leave the **Character Style** field as None.  
5) Show sublevels should be grayed out.  
6) Make sure **Start at** is set to 1.  
7) **Do not** select Consecutive numbering.

As discussed above, the numbered list will adopt the settings of the underlying paragraph style. If you want to use a special font, size or color for the numbering, you can create a character style and apply it in the **Customize** page.

If you want the word **Track** to appear before the number, add it to the **Before** field on the **Customize** page. Do not forget to add a space character to separate the word from the number.

Set up the final parameters of the CDTracks list style on the **Position** page.

1) In the **Level** box, choose 1.  
2) For **Numbering followed by**, choose Tab stop and set it at 4.0cm.  
3) For **Numbering alignment**, choose Right.  
4) For **Aligned at**, choose 1.5cm. (This refers to the alignment of the numbers)  
5) For **Indent at**, choose 4.0cm. (This sets the indentation of the whole list.) Click **OK** to finish.

**Applying the list style**

Now that the list style is available, it can be quickly applied to any list in the document:

1) If you are starting a new list, before pressing **Enter** to start a new line, double-click the desired list style name in the Styles and Formatting deck.  
2) If you already have a list, select it and then double-click the desired list style name in the Styles and Formatting deck.
Note

Remember that applying a list style does not affect the characteristics of the underlying paragraph; therefore you may want to check if you are satisfied with the paragraph style before applying the list style.

If you have more than one list in a document, the second and subsequent lists with the same style continue their numbering from the previous list. To restart at 1, place the cursor anywhere in the paragraph you want numbered 1, right-click, and choose Restart numbering.

To stop using numbering, click the Numbering On/Off icon on the Standard toolbar. The final result is illustrated in Figure 21 on page 25.